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Introduction

The aP23KWCS8S USB Writer is designed to supporudpiP23xxx series Voice chips. It is suitable
for:

- aP23682( 682 sec, 2 I/0 chip) — SOP8
- aP23341( 341 sec, 2 1/0O chip) — SOPS8
- aP23170( 170 sec, 2 I/0 chip) — SOP8
- aP23085( 085 sec, 2 1/0 chip) — SOPS8

This development system serves three main functions
Compiler —to create a dp2 file from user’s Voice files

Writer — to program the dp2 file into the aP23xx chip
Copier —connect DC 5V adaptor for 1 to 1 programming

TheCompiler is used to combine the edited voice files intodhip to form the desired Voice Group
and to define the playback functions of each V@teup by selecting different Options and Trigger
Modes of each individual Voice Group.

TheWriter is used to program the voice data into the aP28exxces that resulted from the Compiler
Function. A Writer Board connected to the PC viB port is required.

TheCopier is using the compiled *.dp2 which loads to writieen disconnect the USB and connect the
DC 5V for 1 pcs copying.
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Installation

Hardware Installation

aP23KWCS8S is a USB based writer programmer. ifitended to be used in Windows ARin7,Win8,
Win10 computer.

Writer Board Connection

1) Connect USB cable from the writer board to the cotep The computer will display a new
hardware is found message. The installation veifjib automatically.

2) If there are too many USB devices are connectggduo computer at the same time, the current
supply from USB may not be sufficient to suppo#d Writer board.
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Fig. 1 The aP23KWC8S USB Writer Programmer Bord
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Running The Software
Double click the file23KWComplier.exeto launch the software.

= COMPILER:
i 2300 Compiler-Va.3 = *
Compiler Writer  About 3 Check Sum : 15.|_|
D 0AC Debounce Voltage Qutput Option:
[2P89341K 1.f v[Key Mode 2| ~|config| 00° @ oms Ossie  ®3  outt -
(4.5v
Wave File | High Volume - | Out2 :LED- Flash
4. Set Oscillator: []%T []Bxt [t
Grou edge Holdable Tri Sto Cutput
o)
[ |’

Type : Compression |——_’—|

CIuLaws 3 ® PCM16 Add-Wav

(P () ADPCM4 7. iSiIence

File Mame Size Rate Type Use %%

_| VaiceFile Prog - Bus Table Use Table Start i
8.
'I'D.I
'13-[' '14.[’ :12.L’ :11.|
Usage : 528 < 1048576 (0% ) LoadDp2 Compiler

COMPILER DESCRIPTION:

1. Select your required IC body.
--- aP23682-8pin , aP23341-8pin , aP23170-8pir23aB85-8pin.
--- aP23682-16pin , aP23341-16pin , aP23170-16aR23085-16pin.
--- aP89682K , aP89341K , aP89170K , aP89085K.

2. Select your required trigger mode.
--- Key mode / CPU parallel mode / MP3 mode / SBten/ 12C mode / aP89 mode / SBT mode.

3. Select voice output mode.
--- DAC or PWM.

4. Show all your required voice files. (Only wale$ acceptable).
--- The [xxx.wav]: 8 bits or 16 bits mono xxx.wav.
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5. Select the compression mode.
--- ADPCM4 / ULAWS8 / PCM8 / PCM16.

6. Select your required voice file [xxx.wav] folder

7. Select if adding the silence.
--- Ims ~ 10000ms.

8. Loading the required *.wav files.

9. Setting your required voice sections and fumctrmde.

10. Show your final voice list.

11. Compiler: After setting the voices & functigrysh the button to create xxx.txt & xxx.dp2 files.
12. Re-download & Re-editing [xxx.dp2] to settingdafunction.

13. Show the memory of your usage.

14. Show the IC body memory size.

15. Show Check Sum.

Page 5 of 35 5/6/2016



lf'LUE Integrated Circuits INCap23kwcss - USB Writer User Guide

de 23KV Compiler-v2.5
Compiler  \yriter About |ChECk Sum: |
D DAC Debnun::e ' Voltage Output Option: 44
‘BP39341K V|| Key Mode IE poyv | ®18ms Oesus @3y 21.|out1:5usy—H
() 4.5y
wave Fie | High Volume &i I Out2 :LED. Fiash
17.
Set Dscnlator Ot OBt =] Int ._l
Grou edge Haldable Tri Stol Qutput
Type : Compression
OuLaws @ PcM1s Add-Wav
() PCMs () ADPCM4 | Silence |
File Mame Size Rate Type Use 3%
VoiceFile Prog - Bus Table Use Table Start T
Usage : 528 < 1048576 (0%) | LoadDp2 | - Compiler
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i 23K Compiler-V2.3 - X
Compiler  yriter  About |Check Sum : |
aP23341 - 8P - | [EANELL - | confia| EASBT Key3 23 || R

T ] PowerOnPlay i' 4.5V
SBT Loop| 25. |
Set Volume &' Int
Tri Stoy Output
Type : Compression L2
e 23K Compiler-V2.5 - e
Compiler  riter  About |Check Sum : |
ap893ak | [EENTEN - | confi =
Wave File PowerOnPlay Y w2 LeD-Flash
Out3 : Stop-H
L1Set Volume Int
@SBT:P,"P&. Tri Sto Dutput
OSBT:P/5S

e 23K Compiler-V2.5 - X

Compiler  wWriter About |Check Sum :
aP89341K  -|[SPI Mode +| config B b
Wave File PowerOnPiay *% | out2s1eD- Fiash

Out3 :Stop-H
L1 Set Volume Int
Ti Stoy Output
1 CPU Serial Option 3'
16. Select required debounce time.

--- 65us or 16ms.

17.

Select if using low voltage detect.

--- Select ON if the IC voltage less than\@&M be reset.

18. Select if using the oscillator.

--- XT (X'tal=16MHz ) / Rosc ext ( 68K ohnY Rosc Int.

19.
--- Busy-H, Busy-L.

Select the output function for outputl, outpai2put3.

--- LED Flash (LED high active ) , ~LED Fla@tED low active ).

--- Stop-H, Stop-L.
--- Prog-BusyH, Prog-BusyL.

--- Load: For the play command [094h+D9~00J9~D0] total 10 bits indicate the voice address.
Same the aP89341 preféitth [no gap loop play].
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20. Select PWM voice output volume.
---Select PWM high volume.

21. Select IC operating voltage at PWM (VOUT).
--- Low Voltage: 3V, High Voltage: 4.5V.

22. IC body configures advanced function.

23. Select SBT pin swap. (for 8pin device only).
--- Select (SBT as OUT1) or (SBT as KEY3).

--- SBT as OUT1: Busy-H/L, Stop-H/L, LED Fad_ED high active),
~LED Flash (LED low active), Prog-BusyH/L, Load.

S3 (pin7) S2 (pin6) Group SBT = OUT1
0 1 SW1 Busy-H/L
1 0 SW2 Stop-H/L
1 1 SW3 LED ......

--- SBT as Keya3:

SBT ( pin5) S3 (pin7) S2 (pin6) Group
0 0 1 SW1i
0 1 0 SW2
0 1 1 SW3
1 0 0 SW4
1 0 1 SW5
1 1 0 SW6
1 1 1 SW7

24. Select power on play.
--- Power on play [swO0] group once.

25. Select SBT loop. (At SBT mode).
--- Enable: The SBT pin sequential triggelo&p play.
--- Disable: The SBT pin sequential triggepl&y once.
*Note: Voice function (Trig Level) must select Lady

26. Select volume control function.
--- Select the volume control Level x16 //x81.

27. SBT pin act play/pause or play/stop functionMi&®3 mode.

28. Select if using pin S4 as data output pin.
--- The SPI mode or I12C mode of data output fopR¥IC body and 16 pin IC body.
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= WRITER:

e 23K Compiler-V2.5

Compiler Writer  Ahout

Grou edge Haoldable Tri Stol QOutput

&

VopiceFile Prog - Bus Table Use Table Start il

2

Check Sum :

5. | 7. 8. 9, 0. 3.
Blank Check Program Verify [ Security !_aP23682 -8Pin v

|11 Run 12 1.
L] 0 % Lﬁi Flash JLna d

WRITER DESCRIPTION:

1. Loading your programming file. (xxx.dp2)

2. Show setting and function after loading *.dg2.fi

3. Show your required IC body.

4. Show voice sections and function mode.

5. Show the content of your selected section afevtist.

6. Select to blank check IC is blank?

7. Select to execute programming.

8. Select to verify the data of your programming.

Page 9 of 35 5/6/2016




JI:'LUE Integrated Circuits InCap23kwess - USB Writer User Guide

9. Select if you need security mechanism.
*** (If do this, it can’t be copied; it can’t be Mzer IC.)
10. Execute your selected (6.) (7.) (8.) (9.).

11. Show the progress of “blank check”, “prografwérify” and “load to flash”.
12. Load to Flash: download the program file (xp2}to [1 to 1 copier] writer.

=  About:

s 23K Compiler-V2.5 - X

Compiler Writer About Check Sum :

1.
JaP23xxx Series Voice OTP Development System

Version 2.5

Aplus Integrated Circuits Inc.

9 :
—waw.aplusmc.com.t\.fu

sales@aplusinc.com.tw

3.
—' Writer Firmware Version Detect

4.
—JFII'I'I'IWEI re Update

ABOUT DESCRIPTION:

1. Show software version.

2. Show website of Aplus Integrated Circuits Inc.
3. Detect writer firmware version.

4. Update writer firmware version.
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= Example for Compiler :

e 23N Compiler-Wa.5 -
Compiler  writer Abaut ) c Check Sum :
— a b_l D 0AC Debounce Voltage Qutput Option:
aP23682 - 8Pin JH Key Mode | config S ©16ms Oesus | @3 | d
- el Oasv
Wave File | High Volume
boku.wav Set LVD: [/ Off []oOn
SR e} Set Oscillator: | |XT | |Bxt /It
MUSIC 02.wav
Super 164, wav w Group edge Holdable Tri Sto| Qutput
Train 01.wav o
| HEEEE =
f Please Select a Folder
Type : Compression |j |
OIuLAWS @ PCM16 Add-Wav
(IpcMa () ADPCM4 Silence | v = Data (D2 ~
w A
File Mame Size Rate Type Use %% s
| wave =
ABT Builder ’e_
I AlVE
| AutaWriter-APP I
Builder_Project
China_Customer
Chi_dll
cus wav o
g
| B’E A
Usage : 528 < 2097152 (0%) | LoadDp2 | | Gompiler

1. Select the IC body is [aP23682 - 8Pin].

2. Select [Key Mode] to be our trigger mode.
3. Select the voice output is [PWM].

4. IC operating voltage at 3V.

5. Select PWM high volume.

6. Click Add-Wav to pick your required folder.
7. After confirming the folder, click the button.

8. All wav files in the folder will be listed here.
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#us 23K Compiler-v2.5 . x
Compiler yyriter About |Check sum : |
_ z D DAC Debounce Voltage Qutput Option:
|aP23682 - 8Pn | Key Mode v |[confia 2% @) Lo Oosis gw
4.5V
Wave File | High Volume w |
boku.wav Set LVD: [ Off [JOn
CHILD.way M Set Oscillator: | |XT | |Ext []Int
MUSIC 02.wav
Super 164 wav Group edge Holdable Trig Stop Output
Train 01.wav
Type : Compression
CIULAWE U IPCMi6 Add-Wav
(® PCMB ) ADPCM4 K Eilence

Al . d Use %
b Silence Time (1 ~ 10000 mS) | 0k
2

C
E:I mS Cancel ‘3‘ VoiceFile Prog - Busy Table Use Table Start Type

Super 16A.wav 5122965 16000 PCMSE 12
Train 01.wav 46615 12000 PCME 2
Silence : 20mS 0 16000  Silence 0

L

i-1|
Usage : 503624 < 2097152 (24 %) | LoadDp2 Compiler

9. Show all your required *.wav files. Double cliakav files you required in h, they will be showed.i
9-1.1f you once required multiple wav files to bdeowed in i. (Mouse left button as begin item after

mouse right button as end item and click Add-MWHv at the same time).
9-2.1t will show the memory size you has been used.

(Please note the data size you loaded can’t exbedoody’s memory).

*** Please note the data size you loaded can't eddbe body’'s memory. If so,

there are some ways to solve this problem:

1). Change it to a bigger memory size boaya®23085-8Pin to aP23341-8Pin.

2). Compressed the wav files to decreasen#traory size. ex: from PCM16 to PCM8.

3). Delete some required voice files.

10. If wav file is too big, we can choose compnegdiles to decrease their sizes.
(UALWS8 compress wav file to 8bits, PCM8 conmgmevav file to 8bits,
ADPCM compress wav file to 4bits).
*** Please note if your original voice is 16bits wéle which need to be compressed to 8 bits,
We suggest you choose ULAW would be better.
11. If you want to add mute voice, click Silencetbn to set the silence time.

12. If need silence 20ms. Key in 20 (unit ms) thieck OK button.
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#e 23N Compiler-V2.3
Compiler  writer About |Check Sum : |
_ ; | | D DAC Debounce l Voltage ﬂ Qutput Option:
|aP23682 - 8Pn - | Key Mode | config| Sy | ® t6me Otus || @3
: o] Oasv
Wave File | High Volume
boku.wav Set LVD: [Foff [(Jon P ﬂ
L Set Oscillator: [ |XT [ TBxt /] Int
MUSIC 02.wav
Super 164, wav | Grou edge Holdable Tri Sto Cutput
Train 01.wav !
|
[
i
Type : Compression ! |
CyuLaws (OPCM1s [ Add-Wav | !
@ PcMa () ADPCM4 [ Silence | |
: [
File Name Size Rate Type Use % I
boku.wav 35650 12000 PCM3 2 | |
CHILD. wav 91676 12000  PCMB8 4 | VoiceFile Prog - Bus Table Use Table Start 15 .
MUSIC 02 wav 73004 12000 PCM3 3 |
Super 16A.wav 512296 16000 PCME 12 | |
Train 01.wav 46618 12000 PCM3 2 |
Silence : 20mS 0 16000 Sience 0 [
|
i
|
i
|
|
l
Usage : 503624 < 2097152 (24 %) | LoadDp2 | | Compiler
e 23KV Compiler-V2.5 = x
Compiler  writer About |ChECk Sum : |
B I ] d tage Qutput Option:
aP23682 - 8Pin - H Key Mode ~||config I1SBT Out1 J =T o s o
S
4.5V
T — ] PowerOnPlay ﬂ
- SBT Loop|t |
CHILD. wav Set Volume ﬂ Int
MUSIC 02.wav
A Tri Sto Output |
Train 01.wav |
: | Close |
Type : Compression = = .
5 . AAA VAT | I
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s 23K Compiler-v2.5 = X
Compiler  writer  About |Check Sum : |
aP89170K  |[SPI Mode - config sl e

Wave File PowerOnPlay V| out2 :1ED-Flash
el ﬂ Volume Warp : [ |Disable []Enable m
;EISLIS:IEI:LEV Set Volume Vol Level : Vol Default: |8  ~

Super 16A.wav V-1 Output
Train 0 L.wav w Set I

CPU Serial Option [7] 5PI - 4 wire : Pin 54 as DO

Close I2C - 3 wire : Pin 54 as DO
Type : Compression
O ULAWS OPcMis Add-Wav PULL-TYPE
Internal PULL-UP
(@) PCMB () ADPCM4 Silence ®
)Mo internal PULL-UP
File Mame Size Rate Type Use %% = e I
boku.wav 35650 12000 PCME 7

13. Select the signal timing. (16ms or 65us).

14. IC operating voltage at 3V.

15. Select PWM high volume.

16. Select set Low Voltage Detect when voltage tleas 2V IC will be reset.

17. Select set Oscillator from Crystal mode(X'téd#Hz), External Rosc mode(68K),
Internal Rosc mode. ( if selecting Crystaldeolt must set at pin MO & pin M1).

18. SBT pin swap other 1/O pin function.
ex : SBT pin swap to OUT1 as output use.

19. Disable the power on play function. It doesinohediately play [SWO0] once.

20. When trigger in “SBT mode”.
If enable the [SBT Loop]: It will one key sequehtidgger and keep loop play in every group.
If disable the [SBT Loop]: It will one key sequaltirigger and play one time in every group.
(*** Note: Trig Level must select Level).

21. Output Option: Setup the outl, out2, out3.
Can select the Busy-H, Busy-L, Stop-H, Stop-L
LED Flash (LED high active), ~LED Flash(LED lowtie),
Prog- BusyH, Prog-BusyL, Load.

22. [Set volume] control function.
---Select the volume control Level x16 / x8 / x4.
---The volume control key by the [M1] and [MO] key.
Volume Warp: Volume level increase to the max thegin from the level 1.
Select disable:
Pin MO: volume Level [+ 1].
ex: Level x8, 2>32>4>52>6>7>8>8>8-> ....
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Pin M1: volume Level [- 1].

ex: Level x8, 7>6>52>4>3>2>1>1>1-> ...
Select enable:
Pin MO: volume Level [+ 1].

ex: Level x8, 22>324>5262>72>82>1>2>3> 4~>....
Pin M1: volume Level [- 1].

ex: Level x8, ®72>6>524->32>22>12>8>72>6>5> ....

23. When set SPI Mode or 12C Mode, the pin S4islédga output (DO) using.

i 23K Compiler-W2.5

Train 01.wav

Unholdable

Retrigger

Unholdable Retrigger

513

Compiler  writer  About |Check Sum :
B I D DAC Debounce Voltage Qutput Option:
aP23682 - 8Pn | Key Mode | config o @temsO6ss | @3 Outt :Busy-H
(1 4.5v

Wave File | High Volume “ |

boku.wav Set LVD: [ Off [Jon

CHILD.wav Set Oscillator: | |XT [ |Bxt I/ Int

MUSIC 02, wav

Super 164, wav Holdable

Enable

i

Trig Lewvel Hold Trigger Stop
= — iLevel (@ Unholdable = (O Mon-Retrigger () Disable
OuLaws OPpcmis Add-Wav (®) Edge () Holdable (®) Retrigger (®) Enable
@ pCMa () aDPCM4 Silence y

SW2 2 4 ok | | cancel
File Mame Size Rate Type Use %%
bk, wav 35650 12000 PCME 2
CHILD. wav 91576 12000 PCM3 4 VoiceFile
MUSIC 02.wav 73004 12000  PCM3 3 T
Super 164, wav 512296 15000 PCM3 12 HILD . waw
Train 01.wav 46618 12000 PCME 2z

Usage : 503736

<. 20897152

{24 %)

LoadDp2

Compiler

24. Double click Panel-A for your setting the fuoatof each Group.

25. Key in group number.

26. SW means group. ex : Select the second gradipd@uble click the wav files you required in (i)

then Panel-B will show them.

The mouse moves to Panel-B then enter right keydar adjusting the order of the wav files or

insert or delete them.
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Jm-t 23KWCampiler-V2.5

*
Compiler  \riter About |ChE”:k it |
o N D DAC Debounce Voltage Qutput Option:
| aP23682 - 8Pin H Key Mode v| Config PWM (®) 16ms (O 65us ®3v Cutl :Busy-H
(4.5v
Wave File | High Volume w |
boku, waw Set LVD: [#off [JOn
L2 th Set Oscillator: [ |XT [ |Bxt /]Int
MUSIC 02, wav
Super 16A. wav Group | edge | Holdable |Trig | Stop | Output
T Oy SwWil Edge Unholdable Retrigger Enable
swz |Edge |Unholdable  |Retrigger |Baakls
SW3 Edge Unholdable Datrigger Add
, z-1 | Multi-Add
Type : Compression SW-Begin: |2 Ok Del
H it
O uLAWS (IPCM16 Add-Wav i
SW-End: Cancel Play
@) PCM3 () ADPCM4 Silence
Trig Level Stop
File Mame Size Rate Type Use % Olevel ® Edge |
Hold
boku. wawv 35650 12000 PCM3 2
{® Unholdable () Holdable
CHILD, waw 91678 12000 PCM2 4 VoiceFile . le Start Type
MUSIC 02 wav 73004 12000  PCM3 3 o Trigger _ _
Super 164, wav 512296 16000 PCMB 12 CHILD.may (O Non-Retrigger (@ Retrigger PCME
: Stop
Train 01 wav 456018 12000 PCM3 2 MUSIC 02.wav PCMB
() Disable (®) Enable
B &
Usage : 503736 < 2097152 (24 %) LoadDp2 Compiler

27. If the mouse move to Panel-A and enter riglyt kewill show there are additional function faildy

multi-add, delete, play and stop.
Add: add single group.
Multi-Add: add multi-groups at one time (z-1).
Delete: delete the group.
Play: play all voices of the group.
Stop: stop the voice playback.
28. Finish compiling, click compiler button.
29. Generate Check Sum number.

30. Loading finished compiled .dp2 file.
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5 x

inm 23K Compiler-V2.5 2
Compiler | writer About |Check Surn : |
. A I | Jpac Debounce Voltage Qutput Cplion:
|aP23682 - 8Pn | Key Mode v|config| D PAC | @ lom Otss @M | outt chusy-
O a5v
Wave File | High Volume e |

Set LvD: A Off [JOn
Set Oscillator: | T Ext Int

_. Groui ’ Edie l Hnidéﬁle l Trii l Stoi ’ Duﬁt .

File is not exist x|
cl |
Type : Compression : - DaAvwavehboku.wav I
O Lwaws @ pamis Add-Wav | 1 I DA\A\wave\CHILD wav 3
(IpCMs () ADPCM4 Silence || P
File Mame Size Rate Type Use % \‘ L
boku. waw ] ] PCMB 0 F
CHILD.wav 0 0 PCMa 0 VoiceFile Prog - Bus Table Use Table Start T
MUSIC 02, wav 73004 12000 PCM3 3
Super 16A. wav 512296 16000 PCM3 12
Train 01 wav 46618 12000 PCM3 2
Panel-C l Play
Stop C-1
Remove
Remove All
Modify Path
sage : 376208 < 2097152 (18%) LoadDp2 Compiler

31. Reloading .dp2 file if the voice file (*.wa\g not exist.

32. The mouse moves to Panel-C then enter rightdeeyour modifying the path of the wav files.
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= How to write the program file [ xxx.dp2 ] to IC :

i 23K Compiler-V2.5 — b
Compiler Writer  About Check Sum : C1B1
Group edae Holdable Trig Stop Qutput D:\Avdemoldemol.dp2
Unholdable Letrigg Key Mode
SW2 Edge Unholdable Retrigger Enable Use: PWM , Low Voltage : 3V
SW3 Edge Unholdable Retrigger Enable VOUT [ PWM ] - Level 6
Powwer On Play: Disable
i Use: Rosc Int
ﬂ LVD: Off
SBT as Outl ﬂ

OutPutl: Busy- H
Execute Blank Check...
Blank Ckeck Success
Execute Program...
Program Finish

VoiceFile Prog - Bus Table Use Table Start Type Execute Verify...
Verify Success

CHILD.wav 1 a 0 PCMB

MUSIC 02 wav 1 4] 0 PCMB

df

Blank Check Program Verify [ Security U_ |aP23682 - 8Pin v‘

Run ﬂ _ﬂ

Load to Flash Load

a. Click [Load] button to load the program file &p2] file.
After loading, it will show Check Sum b~ c~d message.

e. Select Blank Check to check if this IC is blank.
Select Program to execute programming.
Select Verify to execute verification.
Select Security to execute IC security mechanism.
***(To avoid the data to be copied and it can’tdenaster IC).

f. Click Run button to execute all your selectenhis in e column.
(Il show (e.) progress & (b) message).
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e gy n o o L0 anlm‘ ’Eé‘*
o N A L = iﬁﬂ‘

Wefar. 2 o
'Euﬂﬂaﬁni-QI Y-

g. Click [Load to Flash] button to download .dpl2 fio Writer.
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When writer is able to be a 1 to 1 copier. ***qlY must do g. step at first)
1. Disconnect USB.

2. Connect 5V adapter.

3. Push program key to execute programming.

4. When programming, yellow LED flash.

When programming finished, green LED light.
When programming failed , no LED light.
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= Example for About :

s 23KWCompiler-v2.5 = x

Compiler Writer About Check Sum : C1B1

aP23xxx Series Voice OTP Development System

Version 2.5

Aplus Integrated Circuits Inc.

J www.aplusinc.com.tw

sales@aplusinc.com.tw

J Writer Firmware Versiom : V114

J Firmware Update

a. Double click thevww.aplusinc.com.twwill connect website Aplus Integrate Circuits Inc.

b. Double click the Writer Firmware Version will sl writer firmware version.

c. Double click the Firmware Update will load firrave file.
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***Note:

Writer and Copier only support the (*.dp2) fiteom 23KWCompiler version V2.4 or up.

Q1: How to update the latest firmware version.
Q2: How to convert (*.dat) format to (*.dp2) format

Q3: How to convert V2.1 & V2.2 & V2.3 (*.dp2) to V2 or up (*.dp2) format.

Ansl:
e 23KV Compiler-W2.5 o X
Compiler Writer  About Check Sumn :
Grou edge Holdable Tri Stoy Output C:\Users\RD\Desktop\test_file\w2_3-dac.dp2
Writer Disconnect
Writer Information X
VoiceFile Prog - Bus Table_ 8 Writer disconnect
I [
Blank Check Program  MVerify [ Security | aP23682 - 8Pn V|
Run
0 DfO Load to Flash Load

a. Writer must be connected PC after load (*.dp2) file
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b. If Writer doesn’t connect PC, it will show Writeisdonnect message.

e 230N Compiler-V2.5 — x
Compiler  Writer  About |Checl-: Sum : |
Grou edge Holdable Tri Sty QOutput C:\Users\RD\Desktop'test_file\w2_3-dac.dp2
T |
J Firmware Update ot

VoiceFile Prog - Bus

e Update the |atest version firmware

Blank Check Program Verify [ Security | aP23682 - 8Pin v\

Run

U D/ﬂ Load to Flash Load

c. If Writer connects PC,it will show Update the ldtesrsion firmware message.

d. Please click OK button.
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e 230N Compiler-V2.5 — >

Compiler Writer  About | |

Grou edge Haldable Tri Sto Qutput Get Img file [AP243C{_USB_Writer_v114.img)
Execute Update Firmware...

Update Firmware Finish

Please replug in Usb Writer

Firmware Update *

_ —  Update Firmware Finish ...!
VoiceFile Prog - Bus Table Use Please replug in Usk Writer

T T |

Blank Check Program Verify [ Security \ aP23682 - 8Pin v|

Run

0 Dfﬂ Load to Flash Load

e. Atfter finishing firmware update, click OK button@mneplug in Usb Writer.
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due 23N Compiler-V2.5 - X

Compiler Writer About |Check Sum : 3036 |

aP23xxx Series Voice OTP Development System

Version 2.5

Aplus Integrated Circuits Inc.

www.aplusinc.com.tw

sales@aplusinc.com.tw

Writer Firmware Versiom : V114

Firmware Update

f.

You can see About page to check Writer Firmwaresier.
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ANns2:

e 23KWCompiler-V2.5 == it

Compiler  Writer  About Check Sum :

Groui ’ edie ’ Holdable 'Trii ’ Stoi ’ Ouﬁt

i BHET X
4 » TiE » EE » testfile v EE test file 0
EATHE v  HHEEHR = O @
¥ Downloads # ~ =& EuHH =z Fd
W =E #* 1 vi_2-dac.dat 2016/4/28 L5 1_ DAT &= 1,024 KB
= * 190 v1_2-pwm dat 2016/4/28 £51... E= 024 KB
= ER * 0 v2_3-dac.dp2 2016/4/28 +5 1,025 KB
p— 195 v2_3-pwm.dp2 2016/4/28 5 DP2 EE 1,025 KB
pic
test_file
TestGoGo
& OneDrive
I =g
* Downloads
g =
h ==
W =E
BEEEE(N): vi1_2-dacdat v| data files (*.dp2;*.dat) ~
=r{e)] i

a. At Writer page click Load button and select (*.d@g.
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e 23N Compiler-V2.5 — *

Compiler  Writer  About |ChECk Sum |

Grou edge Holdable Tri Sty Output C:\Users\RD'\Desktop\test_file\wvl_2-dac.dat

]
Fdat to *dp2 »

VoiceFile Prog -Busy | | (*dat)file format will be changed to (*.dp2) format

Blank Check Program M Verify [ Security | aP23682 - 8Pin v|
Run
0% Losd to Flach

b. It will show (*.dat) file format will be changed 1¢.dp2) format message.

c. Click OK button.
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e 23K Compiler-V2 5 - X

Compiler  Writer  About Check Sum :

Group edge Holdable Trig Stop Output C:\Users\RD\Desktop\test_file\vl_2-dac.dat

b SEHNE X
4N » T+ EH » testfile v O EE test_file yl

HaEE -  EHEIRE =~ @

[
<t
Er

>
ik
it
]I
m
Ui
il
[
A

]
]
[T v

=l EA # 9 v2_3-dac.dp? 2016/4/28 L5
demo ol w2 3-pwm.dp2 2016/4/28 F5F1..

il iy
o

(=]
=

test_file
TestGoGo

¢@ CneDrive

O Fgg
; Downloads
Ea
EES
W=a
= EE P
EEEEN): v

ZEIFEUT): | data files (dp2) i

~ EEENE e

d. Now save (*.dat) file as (*.dp2) file. The (*.dp2&n be used as the data for program and verify. only
The (*.dp2) file don’t include sufficient informatn for re-load to the compiler.
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Ans3:
e 23K Compiler-V2.5 ol W
Compiler  Writer  about |ChECk Sum :
Grou edge Holdable Tri Sty Output C:\Users\RD\Desktop'test_file\w2_3-pwm.dp2

VoiceFile ’ Pr| CheckSum Information x

| . The checksum will be modfied for new version compiler

Blank Check Program Verify [ Security |aP23682 - 8Pin |

Run

U Dfﬂ Load to Flash Load

a. At Writer page click Load button.

b. Because the check sum rule has been modifiedadtsion V2.4,the check sum maybe different
from the original one.
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Group edge Holdable Trig Stop Output

C:\Users\RD\Desktop\test_fileyw2_3-pwm.dp2

e DTEE X

A s B SE > testhile v|o

[l
<t
_H.'

>
1K
filt

H

5]

ra
[ =T = =]

190 v1_2-new-dac.dp2
demo 1% v2_3-dac.dp2
pic 10 v2_3-pwm.dp2 2016/4/

DP2 B%

[w)
el
[R%]
ik
ol

test_file
TestGoGo

& OneDrive
O F#
& Downloads
E x#
) ==
B =E
=1 EE e
=E L2 O[0 3 new chksun .
EEEAT): |data files (~dp2) =

~ BEEHE s

c. Now save (*.dp2) file as version V2.5 (*.dp2) filehe (*.dp2) include sufficient information
for re-load to the compiler.
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Inserting Devices into the Programmer

- DIP package devices
- Device should be inserted align to the bottom ef8kpin textool socket.
- If you want to program COB, insert it to the COBrecter

For ICOB Connecter|

PCB.: 5483

o ]

=
.
.

| AP23KWCS8S

o ol o Yy o Y e
4 _.‘-e_.-.___,:,:._,lll:L ,.t__,l_ﬂ._liyi--‘:-—-'l.'_F—L-Jl-ri R
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COB Information

AP23xxx_WriterProgrammable /O pin

VDD=VDDA.VDDP
{(Bond Together)

: VSS=VSSA.VSSP
AP23KWCS8S (Bond Together)

V5 AT i D vl el el
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DIE DIAGRAM
e e

L
=
[T T ¥ - T - B ¥ T N " 4 |

VDD
Vou
Vou

| e =]
R = =

L

@
-
O

OTP

00

L Y N | W

=

Programmablepin :
VDD(VDDP ~ VDDA) ~ VSS(VSSA ~ VSSP) ~ VPP ~ S2 ~ S3 ~ RST

Notes:

1. Between VPP and GND should add QK esistor

2. VDDA and VDDP should be connected to the Positioev& Supply.
3. VSSA and VSSP should be connected to the ground.

4. Substrate should be connected to the ground.

*PCB dimension for Slot : 2.28cm x 0.15cm
COB pad pitch : 2.54mm
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HISTORY

2015/04/10
aP23KWCS8S User Guide.

2015/05/20
Dat file become dp2 file.

2015/07/17
Add>Device map & Check Sum

2015/09/18
Add->Low voltage reset & CPU serial option.
Modify>Trigger mode & Silence time & Usage memory size Xe&ute Run component control.

2016/02/01
Add-> Auto detect writer firmware version.
Add-> MP3 mode Play/Pause & Play/Stop option.
2016/02/24
Add->Q&A.
2016/05/06
Add-> Select IC operating voltage.
Add-> PWM voice output volume option.
Modify—> Change LVR to LVD.
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